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Chapter 1: An Introduction to Computer System

Q1.
Ans:

Q2.
Ans:

Q3.
Ans.

Q4.
Ans.

Q5.
Ans.

What is a computer system?

A computer system or simply a computer is an electronic device used to perform a variety of operations on
the basis of a set of instructions called program. A computer takes input from the user in the form of data
or instructions. On receiving the instructions from the user, the computer processes the data and generates
some output and displays it to the user.

List the different types of computers available in the market today.

Computer has become a portable device and a part and parcel of our life. We can see applications of computers
almost everywhere whether it is home, office, school, hospital, hotel, bank, or any other place. The following
is the list of different types of computers available in the market today:

o Desktop Computer

o Handheld Computer or Personal Digital Assistant

o Laptop

o Tablet

o Smart Phone

o Mainframe Computer

o Supercomputer

o Self-destructing Computer

o  Workstation

o Embedded Computer

List the major hardware components of a computer system.

A computer consists of various hardware components, such as system unit, monitor, mouse, and keyboard.
The main hardware components of a computer are explained as follows:

o System Unit: Consists of various smaller components, such as Motherboard, Hard disk, Random
o Access Memory (RAM), Central Processing Unit (CPU), and Sound card.

o Monitor: Displays the output of a computer. It is television-like equipment which can be Cathode
o Ray Tube (CRT), Liquid Crystal Display (LCD), and Light Emitting Diode (LED).

o Mouse: Refers to a pointing device that perfectly fits in your palm and allowsyou to perform certain
activities on screen, such as clicking a button and placing the cursor at a specific location.

o Keyboard: Refers to a device that contains keys to feed information into a computer.

Mention some key software required by an Office computer.

An office computer contains software required for official work such as accounting, customer interaction,

communication, advertising and healthcare. Some key software used for these different purposes are:

o Ledgering system and accounting software such as Tally.

o Data calculation and preparing charts such as Microsoft Excel or Calc.

o Salesforce CRM is a Customer Relationship Management System

o Communication technologies, such as e-mail, chat, Web conferencing, and Voice over Internet Protocol
(VolP).

Mention some common areas of computer application.

Computers have become a part and parcel of our life. We can see applications of computers almost everywhere
whether it is home, office, school, hospital, hotel, bank, or any other place. The following are some common
areas of computer applications:

o Computer Applications in Business
o Computers at Home
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o Computer Applications in Accounting

o Computer Applications for Customer Interaction
o Computer Applications in Communication

o Computer Applications in Advertising

o Computer Applications in Healthcare

o Computer Applications in Education

o Computer Applications in Engineering

o Computer Applications in Law Enforcement
o Computer Applications in Governance

o Computer Applications in Manufacturing

o Computer Applications in Military

o Computer Applications in Music

o Computer Applications in Film and Television

Elaborate the working of a computer with the help of an analogy.

A computer performs a task in the same manner as we do our day-to-day activities. For example, when we
want to prepare some cookies, first we take some raw ingredients such as flour and sugar (as an input), bake
these ingredients with the help of an oven (as a process), and finally get the cookies (as an output). In the
same manner, the computer takes data from the input devices, processes it, and displays the output.

What are the different features of a computer?

Today, you can find computers in almost all spheres of life whether it is school, workplace, or home. The

following are some qualities that facilitate such wide use and popularity of computers:

o Speed: Computers perform at great speed and have the capability of processing even the most complex
computations in a matter of seconds.

o Storage capacity: The storage capacity of a computer defines how much information can be stored in it.
Nowadays, storage capacity of hard disks can be in terabytes (TBs).

o Reliability: The electronic components in modern computers make them more reliable as they rarely break
or fail.

o Accuracy: Computers have the ability to provide accurate results as they perform computations with
utmost accuracy.

o Consistency: A computer generates consistent results, if provided the same input and processes.

o Versatility: Computers are able to perform different tasks in a variety of domains, such as education,
entertainment, healthcare, accounting, and hospitality.

List some limitations of a computer.

Although computers provide accurate results, yet they have some limitations as compared to human beings.
The following are the limitations of computers:

o No Power to Make Decisions: Computers are unable to take decisions on their own; instead, they depend
upon the input being provided by humans.

o No IQ: Computers are machines that do not have self-intelligence; instead, they need to be informed time
to time regarding the tasks to be performed.

o No Heuristics: Computers are not able to learn from their past experiences. It implies that when a
computer commits an error once, then it would commit the same mistake again in a similar situation.

What is technological convergence? Explain 3Cs of technological convergence.

The emerging trend of technological convergence has led to the merging of many technologies: computing,
content, and communications into a single system. The merger of these three technologies is referred to as
the 3Cs of technological convergence.
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The 3Cs of technological convergence are explained as follows:
o Computing: It refers to the design and construction of computers to perform various types of tasks.

o Content: It refers to any type of meaningful data or information that is expressed through some medium,
such as speech, writing, or images.

o Communications: It refers to the interaction of multiple computers over a network to share data,
information, and other resources.
Q10. List the types of technological convergence.

Ans. Depending on the technologies involved, convergence can be of the following types:
o Digital Convergence: Refers to the merger of the Internet, telecommunication, and leisure industries.

o Messaging Convergence: Refers to the integration of text and voice messages. For example, text SMS,
voice SMS, Interactive Voice Response (IVR), Multimedia Messaging Service (MMS), etc.

o Media Convergence: Refers to the convergence of various mediums such as text, audio/video, etc. Media
convergence has greatly impacted our daily life and even transformed the way we perform our routine
activities.

o Content Convergence: It refers to the integration of content from various sources on the Internet.

Chapter 2: Exploring Computer Components

Q1. What does the term input device imply? Mention different types of input devices.
Ans. A device that lets you enter data or instructions in a computer is known as an input device. The following are
the different types of input devices:
o Keyboard
o Mouse
o Joystick
Scanner

o

Optical Character Recognition

o O

Magnetic Ink Character Recognition
Light Pen

Bar Code Reader

Microphone

o

o O

o

Digital Camera
o Web Camera

Q2. ‘Central Processing Unit is known as the brain of the computer.’ Elucidate.

Ans. Central Processing Unit (CPU) is a physical device that controls computer operations. It is known as the brain
of a computer system as it controls all the operations of a computer on the basis of the instructions specified by
a user. It looks like a small chip and is placed on the motherboard. The power of CPU lies in its ability to process
data rapidly and flawlessly. The speed of CPU is measured in Megahertz (MHz) or Gigahertz (GHz).

Q3. Define output devices. Mention different types of output devices of a computer.
Ans. An output device is electronic equipment that is connected to a computer and is used to communicate results
of the processed data to the user. The different types of output devices used by a computer are:

o Monitor: The term monitor is often used to refer to a computer screen as it displays programs, allowing
the user to interact with the software.

o Printer: A printer is an output device that prints the data processed by a computer. The printer generates
a hard copy known as printouts of the document.

o Plotter: A plotter, similar to a printer, produces a hard-copy output. Plotters are ideal for engineering,
drafting, and many other applications that require intricate graphics.

Practice Test Answers-Class IX




Q4.
Ans.

Q5.
Ans.

Q6.
Ans.

Q7.
Ans.

Q8.
Ans.

o Speaker: A speaker is an output device that produces sound. It receives sound in the form of electric
current from a sound card and then converts it into the sound format.

Explain the concept of computer memory in detail.
Memory is the area where you can store information. There are two types of memory available in a computer
— primary memory or main memory and the secondary memory. These are explained as follows:

o Primary Memory: Primary memory is the main memory in a computer system where data is stored
temporarily for quick access by the CPU. There are two types of primary memories:

e Read Only Memory (ROM)
o Random Access Memory (RAM)

o Secondary Memory: The secondary memory is also known as secondary storage and is used to store the
data permanently. The data can be stored in floppy disks, hard disk, CDs, DVDs, SSD and BDs.

List the different units of computer memory.

A computer stores data in units called bits and bytes. Bits are grouped together in sets of eight. Each set of
eight bits is called a byte. Apart from the byte, there are various other units of memory. The following is the
description of the units of memory in a computer:

o Byte (B) = 8 bits

o Kilobyte (KB) = 1,024 bytes.

o Megabyte (MB) =1,048,576 bytes = 1024 KB

o Gigabyte (GB) = 1,024 megabytes

o Terabyte (TB) = 1,024 gigabytes

o Petabyte (PB) = 1,024 terabytes

o Exabyte (EB) = 1,024 petabytes

o Zettabyte (ZB) = 1,024 exabytes

o Yottabyte (YB) = 1,024 zettabytes

o Brontobyte = 1,024 yottabytes

o Geopbyte = 1,024 brontobytes

What are portable memory devices? Elucidate.

Portable memory devices refer to the memory devices that are portable and used to store data. Some of the

commonly used portable memory devices are:

o Pen drive/USB flash drive: Pen drive is a data storage device. It is also known as a Universal Serial Bus (USB)
flash drive, which is typically a small, lightweight, removable, and rewritable device.

o Memory stick: A memory stick is another memory storage device. It is a removable flash memory card that
is used in electronic products, such as mobile phones and digital cameras.

Discuss the components of the CPU.

A CPU typically two components. These components are:

o Arithmetic Logic Unit (ALU): ALU is a digital circuit that is used to execute arithmetic and logical
operations in a computer system. ALU performs the arithmetic and logical operations, such as addition
(+), subtraction (-), greater than (>) or less than (<). The logical operation returns True or False as the
result.

o Control Unit: It extracts instructions from the computer memory, decodes and executes instructions,
and takes help of ALU if required. The control unit of the CPU supervises and monitors the functions
performed by the entire computer system. The instructions in each program are transferred, one at a time,
to the control unit.

What do understand by a computer mouse? Explain different types of mouse in brief.

A mouse is a basic input device of a computer. It controls the movement of the cursor or pointer on the
display screen.
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The following are the different types of mouse:

o Mechanical Mouse: Refers to a mouse in which the movement of cursor on the screen is relative to the
movement of the ball at the base of the mouse. To use the mechanical mouse efficiently, you need a flat
surface or mouse pad.

o

Optical Mouse: Refers to a mouse that uses a Light Emitting Diode (LED ) to detect the movement of
cursor on the screen. This type of mouse does not work on a black or shiny surface.

Laser Mouse: This type of mouse uses infrared laser diode for detecting the mouse movement.
BlueTrack Mouse: This type of mouse is based on the BlueTrack technology. The technology, introduced by
Microsoft, states that the device can work on any surface from a granite countertop to the carpet.

Q9. Write a note on the advantages and disadvantages of a scanner.

Ans. The following table compares the advantages and disadvantages of the scanner:
ADVANTAGES DISADVANTAGES

It can produce an image with a very high resolution ~ An image can occupy a lot of memory space
as compared to a digital camera

It can convert any paper document into digital The quality of the scanned image totally depends
format upon the quality of the original document

Q10. Write a note on the advantages and disadvantages of an OCR.
Ans. The following table compares the advantages and disadvantages of the OCR:

ADVANTAGES DISADVANTAGES

OCR is much faster than manually typing the It is necessary to purchase an OCR software
information

There are various new facilities, such as creating The accuracy of an OCR is not 100%

tables, columns, and Web pages in the latest
version of OCR

You can edit the information that is converted into  Proofreading is required for the text which has been
a soft copy by using an OCR converted into a soft copy by an OCR

Chapter 3: Exploring Computer Software

Q1. Cite major differences between hardware and software.

Ans. The following table shows the differences between hardware and software:

HARDWARE SOFTWARE

Hardware denotes the physical components of a Software denotes the logical components of a
computer computer

Hardware is a tangible entity that can be seen and  Software is an intangible entity that can be only
touched felt, but not touched

Input and output devices, CPU, floppy disk, Operating systems, word processors, device drivers,
hard disk, CD, and DVD are important hardware and language processors are important software
components of a computer components of a computer

Q2. What the different categories of software?

Ans. There are two major categories of software — System Software and Application Software.

o System Software is further classified into four categories — Operating System (OS), Language Processors,
Device Drivers, and Utility Software.

Practice Test Answers-Class IX




o Application Software is classified into three categories — General Purpose Software, Specific Purpose
Software, and Customized Software.

Q3. Explain the term, ‘System Software’ in detail.
Ans. The software that is responsible for controlling a computer’s internal operations, handling input/output devices,
and scheduling tasks is known as system software. The four different categories of system software are:
o The Language Processor: The system program that performs conversion of an HLL program into a low-
level language is known as a language processor.

o The Operating System (OS): The software that controls and manages the hardware is known as the
operating system (OS). The OS enables a user to conveniently handle the computer and make the best use
of its hardware.

o The Device Driver: A device driver is a specially written program that converts the command given by the
OS into a format that is easily understandable by peripheral devices.

o The Utility Software: Utilities are defined as helpful software that help a computer to perform various
functions, such as analyzing and configuring data, optimizing and maintaining resources.

Q4. Explain the term, ‘Application Software’ in detail.
Ans. Software that is designed to accomplish a specific task is called application software. Application software is

classified into the following three categories on the basis of their use:

o General Purpose Software: General purpose application software or packages are required to perform
all other tasks, such as processing a text document, managing database, preparing presentations, and
designing graphics

o Specific Purpose Software: Specific purpose software is a type of software that is created to execute only
a specific task

o Customized Software: Customized software refers to software developed by an in-house development
group, a software firm, or an independent software developer for a particular group or organization

Q5. What are the different generations of programming language?

Ans. Programming languages can be classified into the following four generations:

o First Generation Languages (Machine Languages): Machine languages are categorized as first generation
languages (1GLs). In machine language, instructions contain long strings of Os and 1s, making a program
fragment look something like “010101010110”.

o Second Generation Languages (Assembly Languages): It is a low-level language written by using
mnemonics and requires an assembler for binary conversion of instructions.

o Third Generation Languages (High-level Languages): Third generation programming languages are also
known as high-level languages. 3GLs are simple to understand by humans, as they include easy-to-learn
syntax.

o Fourth Generation Languages: Fourth generation languages require fewer numbers of lines to develop a
program. The languages focus on WHAT to do rather than HOW to accomplish a given task.

Q6. What is the difference between a low level and high level program?

Ans. The following table shows the differences between the low level and high level program:

LOW-LEVEL LANGUAGES (OR LLLS) HIGH-LEVEL LANGUAGES (OR HLLS)

Programming languages that are directly Programming languages that are more or less
understandable by a computer independent of a particular type of computer
These languages are often described as being “close As an HLL program is written in a human-readable
to the hardware”, which means there is no need format, these languages are described as being
of any translator software to convert the source “close to the human language”

program into machine-readable instructions

Some examples of low-level language are Some examples of high-level languages are C,

. FORTRAN, Pascal, and Java
assembly language and machine language
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Q7. List some useful application software.

Ans. Some useful application software are:

o

Word Processing Program: A word processor enables you to enter, edit, format, and print text. Moreover,
it enables the PC to function like a sophisticated typewriter.

Spreadsheet Program: A spreadsheet program allows you to organize, analyse and store data in a tabular
form. It provides the basic arithmetic and mathematical functions.

Database Program: Database Management System (DBMS) or database program refers to software that
provides important tools to create and manipulate data in a database.

Graphics, Multimedia and Presentation Program: Multimedia software allows you to create and modify
animations. A presentation program enables you to represent information in a number of attractive
formats

Desktop Publishing Software: Desktop publishing refers to the process of using the computer to create
documents, such as brochures and magazines.

Browser: A browser is a type of application software that is used to explore, retrieve, and present the
information available on the World Wide Web (WWW).

Personal Information Manager (PIM): Personal Information Manager (PIM) helps you to organize
information. PIMs enable you to enter various kinds of textual notes, such as reminders, lists and dates,
and link these notes together in useful ways.

Q8. List some useful utility software.

Ans. Some useful system software are:

o

o

o

o

o

Text Editor: Text editor is utility software that assists you to create an editable text file.
Backup Utility: The backup utility software helps to secure data.
Compression Utility: The compression utility facilitates compression of files.

Disk Defragmenter: Disk defragmentation is a utility program that tries to minimize the fragmentation
on the disk.

Antivirus Software: Antivirus software protects your computer from unexpected virus attacks.

Q9. List some useful specific software.

Ans. Some useful system software are as follows:

o

Accounting Software: Accounting software is mainly used in organizations to record and keep track of
business revenues, payrolls, receivables, and payables on a periodic basis.

Reservation Software: It helps holiday makers and business travellers by arranging attractive holiday
packages and business tours for them.

Human Resource Management (HRM) Software: This software manages employees-related data in an
organization.

Attendance Software: It refers to the software that tracks the attendance of students and employees in a
schools, colleges, or organizations.

Payroll Software: This software keeps track of the financial records (such as salary, bonus, and deductions)
of an employee.

Inventory Management Software: This software automates the processes of inventory management, such
as receiving, storing, tracking, shipping, and accounting of inventory.

Billing Software: This software performs all tasks related to the billing process, such as creation of
invoices, receipts, and purchase orders.

Q10. Write a note on the advantages and disadvantages of customized software.

Ans. The following table compares the advantages and disadvantages of customized software:

Practice Test Answers-Class IX



ADVANTAGES DISADVANTAGES

The software possesses only those features that are It takes a long time and money to develop

required by an organization customized software

The software works according to the business A team of business analysts, programmers, and
needs of an organization testers is required to build a customized application

It is better to opt for customized software than buy Customized software cannot be directly installed

new software because it can be customized to fulfill everywhere because of the lack of necessary

the different needs of an organization infrastructure and resources required for its
installation

Chapter 4: Communication Technology

Q1. Define a computer network.
Ans. A network is defined as a collection of devices connected together. A computer network is a group of two or
more computers that are linked with each other so as to:
o Share files with other computers in the network
o Share resources, such as printers, hard disks, and fax machines
o Share application software (such as MS Office) over the network
o Allow electronic communication (such as e-mail, messaging, etc.)

Q2. List some benefits of computer networking.

Ans. The benefits of networking are as follows:
o Allows you to share data from anywhere
o Allows you to share all types of data, such as text, audio, video, pictures, and graphics
o Reduces cost by sharing hardware and software resources
o Saves time by transferring data from one computer to others
Provides high reliability because there are multiple sources of supply
Increases productivity by easily sharing data

Q3. What are the different types of network?
Ans. Networks can be classified on the basis of their size, complexity, and the geographical area covered by them.

As per geographical area, networks can be classified into three types:

o Local Area Network (LAN): LAN is a localized network. This type of network is useful when you want to
connect two different departments in a building.

o Metropolitan Area Network (MAN): MAN is the bigger version of LAN. MAN covers a larger area than LAN,
but smaller than WAN. MAN generally connects two or more LANs or Campus Area Networks (CANs),

o Wide Area Network (WAN): WAN is a type of network used to cover a wide geographical area or region. It
links different metropolitans, countries, and national boundaries. It may be located entirely within a state
or country, or it may be interconnected around the world.

Q4. List the different components of a computer network.

Ans. A computer network consists of five components. These are:
o The Sender
o Communication equipment at the sender side (Modem)
o Communication channel (Telephone lines)
o The receiver
o Communication equipment at the receiver side (Modem)
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What is a transmission media? What are its different types?

The transmission media is a medium that enables you to transfer data from one computer to another. In the
case of computers, transmission media is the cable that allows communication between computers. All these
media are categorized into two types. These are:

o Guided or Wired Media
o Unguided or Wireless Media

List the advantages and disadvantages of Infrared waves as a data communication medium.

The following table shows the advantages and disadvantages of infrared waves as a data communication
medium:

ADVANTAGES DISADVANTAGES

Fairly reliable It is a line-of-sight technology. For example, you
have to point the remote control at the television to
make it work.

Does not cost very much to add into a device It is always a one-to-one technology, which means
that the data can be transferred only between two
devices at a time.

Explain the working of a computer modem.

Modem is a device, which is used to transmit data over a network. In a network, while computers are
communicating, a computer from the sender side sends data in binary code to a modem. The modem at the
sender side converts the binary-coded data into analog signals. Then, these signals travel along the telephone
network. When the data reaches the destination computer, the modem connected to that computer converts
the analog signals back into binary-coded data, which can be read by the computer.

What is the Internet?

The Internet refers to a collection of an infinite number of computers spread across the world. It is the
largest computer network (a group of interconnected computers that can interact with one another) in the
world. The Internet is also called a network of networks as it encompasses many small, medium, and large
networks. The Internet allows people to communicate with each other all over the world. As compared to the
traditional broadcasting media, it is a decentralized system, which means that it has no centralized control.
The interaction between two entities is not affected/observed by a third entity.

Define the Interspace.

InterSpace is a client/server program that allows multiple users to communicate online with real-time
audio, video, and text chat in dynamic 3D environments. It is the future vision of Internet as it provides the
most advanced form of communication. Unlike Internet, InterSpace allows interconnection of spaces for
manipulation of information. Unlike technologies that help in searching information to analyze and correlate,
the InterSpace offers distributed services to transfer concepts across multiple sources.

Define data, information and multimedia.

The definitions are described below:

o Data is defined as a raw fact that does not have any meaning. Data can be numbers, measurements, and
observations. It can also be qualitative or quantitative.

o Information is defined as the data that is interpreted and is presented in a useful manner to the user.
Information can be used to take important decisions by an organization in its planning, competition
strategy, marketing, etc.

o Multimedia is defined as the combination of text, graphics, sound, special effects, and animation.
Generally, multimedia is everything that you can see and hear.
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Chapter 5: Introducing Commonly used Operating Systems

Q1.
Ans.

Q2.
Ans.

Q3.

Ans.

Q4.
Ans.

Q5.
Ans.

What is an operating system?

Operating system is the most important type of system software. It acts as an interface between user and
hardware resources of a computer system. It is in charge of controlling all the activities of a computer system.

What are the different components of a computer system?

There are four important components of a computer system:

o Hardware: Refers to those components that can be seen and touched, such as the Central Processing Unit
(CPU), Random Access Memory (RAM), monitor, and keyboard.

o Operating System: Refers to the software that controls and coordinates the use of hardware resources of
a computer system.

o Application Programs: Refers to the programs that are developed to solve the computing problems of
the users.

o User: Refers to the person who uses the application software installed on the computer system.

Mention some basic operations of an operating system.

The operating system is a crucial software component of a computer. It performs the following basic and
important operations in the computer:

o Recognizes the input entered by the user (such as a key press or a mouse click)

o Displays the generated output on the computer screen

o Keeps a log of the files and directories on the hard disk

o Manages the various peripheral devices of the computer (such as printers and scanners)

Classify different operating systems.

Today, various types of operating systems are available in the market. Broadly, operating systems can be
classified into the following seven categories:

o Single-program operating system: Executes only one program at a time.

o Multiprogram or concurrent operating system: Allows the computer’s CPU to execute more than one
program simultaneously.

o Time-sharing operating system: Allows the concurrent use of a single computer by more than one user.
In a time-sharing operating system, the processing of a task switches among various users based on the
available time, which is controlled by the operating system.

o Multiprocessing operating system: Executes multiple programs simultaneously on a computer that has
several CPUs, such as mainframes and super computers.

o Real-Time Operating System (RTOS): Refers to the operating system that is designed to provide immediate
and accurate responses within the allocated time constraint.

o Distributed operating system: Refers to an operating system that manages a number of independent
computers and hardware devices that make up a distributed system.

o Interactive operating system: Contains a GUI that allows a user to easily interact with a computer.
Briefly explain about the process and process management of a computer system.

A program can be defined as a set of instructions given to a computer to accomplish a certain task. This
program, when being executed, is called process. The management of a processor (or CPU) by an operating
system is known as processor management. Processor management is also referred to as CPU scheduling.
The components of a process are:

o An object program that needs to be executed

o Data to be processed by a program

o Resources needed by a program

o Status of process execution
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Q6.

Define job scheduling.

Ans. Job scheduling is the activity or method of assigning priorities to different jobs to be executed by the CPU. In

Q7.
Ans.

Q8.
Ans.

Qo.
Ans.

Q10.
Ans.

other words, it is decided through job scheduling that when a particular job will receive the CPU or computer
resources that it needs for its completion. So, the start of a job execution depends on job scheduling.

What is memory management? Explain in brief.

Memory management is the process of allocating memory to different programs and freeing up memory space
when it is no longer needed by the programs. Managing the memory of a computer is a highly important
task of the operating system. There can be several user programs, system programs, and operating systems
loaded into the memory at the same time. In such situations, an effective memory management technique is
required. The following are the different techniques used for effective memory or storage management:

o Contiguous storage allocation
o Virtual storage with the use of paging
o Non-contiguous storage allocation

o Virtual storage with the use of segmentation
What is device management in a computer?

Device management is an important feature of the operating system. It can be defined as the process of
activating and controlling peripheral devices (such as mouse, printer, or keyboard) attached to a computer.
The operating system manages the various devices with a tool known as the device manager. This tool helps
to view and modify the properties of all the devices attached to a computer. The device manager consists of
the following two parts:

o Device-dependent parts
o Device-independent parts

Write a note on the file management by an operating system.

The operating system manages and protects the information and resources available on the computer system.
It ensures that the owner of the information is able to control that information, and that two concurrent
resources should not interfere with each other. The operating system performs the following functions with
respect to files and directories:

o Creates and deletes files

o Creates and deletes directories

o Allows manipulation of files and directories

o Allows backup of files on storage devices, such as magnetic tapes

List some distinct features of GNU Linux operating system.

Some of the distinct features of the GNU Linux operating system are as follows:

o Open source operating system: Anyone can freely use the Linux operating system. In other words, anyone
can see its source code, modify it, and redistribute it.

o Virus free: The Linux operating system rarely gets attacked by computer viruses. In contrast to other
operating systems, Linux provides better security.

o Stable, long-running operating system: The Linux operating system almost never hangs up or hardly
encounters system crashes. You can run Linux for days and months together without any need for restart.
This is why Linux is used in most of the Internet servers.

o Multiple workspaces: The Linux operating system allows you to use four desktop screens (known as
workspaces) simultaneously. You can switch anytime from one workspace to the other. However, in other
operating systems, such as Windows, there is only one desktop screen, and if it gets filled up, you have
to clean it.

o No constant rebooting: It allows you to install and remove software without rebooting the computer.
Start/stop services: It enables you to start and stop individual services, such as Web, file, and e-mail
services, without either rebooting the computer or interrupting the work of a user.
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o Portable software: It modifies an application or driver to make it work on different computer architectures
or operating systems.

o Downloadable applications: It helps you to download and install the required applications with a single
command with the help of tools such as apt, urpmi, and yum.

o No settings hidden in code or registries: It allows you to modify the code according to your requirement.
o Flexibility: It allows you to select any Linux distribution package and access its source code.

o Swap space: It provides swap space, which is the area on the computer hard disk used to handle the
overflow of running processes and data.

Chapter 6: Word Processing Tool —0OpenOffice Writer-|
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What is a word processor? Mention some of its features.

A word processor is used to process textual matter and create organized and flawless documents. The word
processor has all the features of a conventional typewriter. Besides, it has various new features that have
helped users overcome the limitations posed by conventional typewriters. Some of the features of a Word
Processor are:

o Fast speed: The speed of typing in the word processor is very fast as compared to any conventional
typewriter.

o Easy editing: The word processor allows you to perform all types of editing tasks in a text document, such
as insertion, deletion, and modification.

o Permanent storage: The word processor saves your text document, and you can access your saved
document whenever you need it.

o Simple formatting: The word processor enables you to format your document easily.

o Adding graphics: The word processor facilitates insertion of pictures, diagrams, and other visual elements
into text documents.

o Spell check: This feature enables you to check spelling mistakes in a document.

o Object Linking and Embedding (OLE): This feature facilitates linking or embedding objects such as charts,
equations, videos, audio, and graphics in a document.

Mail merge: This feature enables you to type or print more than one document with similar text.

Word wrap: This feature facilitates automatic organization of the text into lines. It means you need not
press the Enter key when you reach the end of a line.

o Find and replace: This word processor feature enables you to find and replace a particular word in a
document.
Write a note on OpenOffice Writer.

OpenOffice Writer (or Writer) is a word processor that is part of the OpenOffice suite. OpenOffice Writer helps
you create different types of neat and attractive text documents, such as fax documents, reports, and personal
and professional letters. The most useful features of the OpenOffice Writer include spell-checker, grammar-
checker, easy insertion of text, and numerous formatting features.

Define margin. Explain different types of margins.

Margins refer to the blank white areas that exist between the text and the edges of a page. Every page has
top, bottom, left, and right margins. The area within these four margins, where you write, edit, and format
the text, is known as the document area. Therefore, if you increase or decrease the margins of a page, your
document area will also decrease or increase accordingly. The ruler line indicates the positions of the margins.
The margins are of four types, namely:

o Left margin: Refers to the distance between the text and the left edge of a Writer document

o Right margin: Refers to the distance between the text and the right edge of a Writer document

o Top margin: Refers to the distance between the text and the top edge of a Writer document

o Bottom margin: Refers to the distance between the text and the bottom edge of a Writer document
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What do you understand by the term Word Wrapping?

Word wrapping is a special feature of the Writer that arranges the words according to the set margins. It
means that if a word does not fit in a line, it automatically comes at the beginning of the next line and you are
not required to press the Enter key on the keyboard to come to the next line. This feature of automatically
fitting the text is known as word wrap.

Define indentation. Explain different types of indentations.

The space that is left between the left and right margins of a paragraph in a page in known as indentation. It
refers to the space between the text and the page margins. Indents are of three types, which are described
below:

o Positive Indent: Keeps the text a little inward from the margin.
o Negative Indent: Keeps the text a little outward from the margin.

o Hanging Indent: Keeps the text a little inward from the first line. The hanging indent is generally used for
bulleted terms, numbered lists, and glossary terms.

Explain line spacing in OpenOffice Writer.

Line spacing refers to the space between two or more lines in a document. There are several line spacing
options available in the Writer. These are listed as follows:

o Single Proportional

o 1.5 lines At least

o Double Leading

o Fixed

Write a note on headers and footers in OpenOffice Writer.

Headers and footers allow you to add important information at the top or bottom of a page. Header defines
the area above the top margin of a page while footer defines the area below the bottom margin of a page.

You may include some vital information in headers and footers, such as the chapter title, company logo, page
number, creation date, and author name.

What does the Find and Replace feature do in OpenOffice Writer?

The Find & Replace feature of the OpenOffice Writer helps you search a particular word, phrase or sentence
in your document. This feature is particularly useful in finding the desired text easily in large documents. The
Find & Replace feature also enables you to replace a word or phrase in your document at all occurrences with
another word or phrase. With the help of Find & Replace feature, you can do this replacement any number of
times within minutes. This feature can be used by selecting the Find & Replace option in the Edit menu.

Write a note on formatting in OpenOffice Writer.

A document in OpenOffice Writer can be created in a number of formats. You can format the text in a
document to improve its appearance and make it presentable and attractive. Formatting helps in highlighting
important text by differentiating it from the regular style. The process of arranging text in a document in a
particular way by changing text alignments, font, and size is called formatting. Different types of formatting
are available in OpenOffice Writer:

o Character formatting

o Paragraph formatting

o Page formatting

How can we insert special symbols in OpenOffice Writer?

Sometimes you need to add some special symbols in your document, such as copyright symbol (©) and
trademark symbol (™). These symbols cannot be inserted through the keyboard. To insert these symbols in
your document, you need to select the Insert=>Special Character option from the Menu bar. Select a symbol
from the Special Characters dialog box that appears to insert the symbol in your OpenOffice Document.
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How can we apply bullets in an OpenOffice document?

Bullets are symbols used to present text in the form of a list. Perform the following steps to apply bullets in a
document:

1. Select the list items to which you wish to apply bullets.

2. Select the Format->Bullets and Numbering option from the Menu bar.

3. Select the desired bullet type from the Selection section under the Bullets tab of the Bullets and
Numbering dialog box.

4. Click the OK button. The selected bullet type is applied to the selected list items.
What is Spell Check in OpenOffice Writer? What are the different ways to spell check a document?

The OpenOffice Writer allows you to carry out automatic spelling and grammar check to correct language
errors in a document. The Writer contains built-in dictionaries that help spell check a document. The following
are the two ways of checking spelling and grammar of a document in the Writer:

o AutoSpellcheck: Refers to a utility that automatically checks the spelling and grammar mistakes in a
document.

o Spelling and Grammar: Refers to a utility that you need to start manually for checking spelling and
grammar mistakes.

What does AutoCorrect imply in OpenOffice Writer? How can we add a new Auto Correct Word in OpenOffice
Writer?

OpenOffice Writer provides the AutoCorrect feature that checks the format of particular types of words for
which you specify a defined format. The AutoCorrect option can be customized as per the user requirement.
Perform the following steps to add a new AutoCorrect word in OpenOffice Writer:

1. Select Tools=>AutoCorrect Options from the Menu bar. The AutoCorrect dialog box appears with the
Options tab.

2. Click the Replace tab in the AutoCorrect dialog box.
3. Insert the new AutoCorrect word in the Replace text box and the complete word in the With text box.
4. Click the OK button to apply the changes.

Write a note about graphics in OpenOffice Writer.

In OpenOffice Writer, the word graphics stands for pictures, shapes, and stylish text. The OpenOffice Writer
application provides facility to add graphics in a document. Once you have added a graphic to your document,
you can modify it whenever required. You can add a border to a graphic available in the Writer and also
provide effects to it. The following are two basic types of graphics available in OpenOffice Writer:

o Drawing objects

o Pictures

How can we change the color or the style of a line in OpenOffice Writer?

Suppose, you have drawn a line and you want to change its style and color. Perform the following steps to
change the style and color of the line:

1. Select the line whose style and color you want to change.

2. Select the Format->Object->Line option from the Menu bar.

3. Select the desired style and color from the Line dialog box.
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Define a textbox. How can we insert a textbox in OpenOffice Writer?

A text box can be defined as a box where you can type your text. By default, it is rectangular in shape. A text
box can be moved, grouped, ungrouped, or rotated like any other drawing object. Perform the following steps
to insert a text box in your document:

1. Click the Text icon on the Drawing toolbar.
2. Move the cursor to the place where you want to draw the text box.
3. Click and drag the cursor to draw the text box. Type your text in the text box.

Explain the steps to group and ungroup drawing objects in OpenOffice Writer.

By default, all the objects that you insert in your document are treated as separate objects. To treat all
the separate objects as a single object, you can group them. Perform the following steps to group drawing
objects:

1. Select all the drawing objects that you want to group.

2. Select the Format—=>Group—=>Group option from Menu bar.

Once the objects are grouped, you can move, copy, cut, delete, and rotate them together. Similarly, you can
ungroup the grouped objects. Perform the following steps to ungroup objects:

1. Select the grouped objects.

2. Select the Format->Group->Ungroup option from the Menu bar.

Define a table. How can we insert a table using the Table icon in OpenOffice Writer?

A table is a grid of cells created by the intersections of corresponding rows and columns. A table is used for a
variety of tasks — from presenting numerical data to creating unique layouts. To insert a table using the Table
icon on the Standard toolbar, perform the following steps:

1. Place the cursor where you want to insert the table.
2. Click the arrow button of the Table icon on the Standard toolbar.

3. Select the required number of rows and columns by dragging the mouse. As you drag the mouse, the
selected rows and columns get highlighted.

4. After selecting the desired number of rows and columns, click the mouse on the last cell. The table is
inserted at the insertion point in the document.
How can we format a table in OpenOffice Writer?

You can change the appearance of a table by changing the border and color of cells. Apart from changing the
appearance of your table manually, you can use the AutoFormat option to apply some predefined formatting
styles to your table. Perform the following steps to use the AutoFormat option:

1. Select the table by clicking on a cell.
2. Select the Table>AutoFormat option from the Menu bar. The AutoFormat dialog box appears.
3. Select the desired format of the table and click the OK button. The selected format applies to the table.

What is Track Change in OpenOffice Writer? Explain the steps to use the Track Change feature in OpenOffice
Writer.

It is possible that an OpenOffice Writer document may be edited by multiple users. To track or record the

changes of each user, the OpenOffice Writer provides the functionality for tracking changes. When this

functionality is enabled in the document, you can view all the previous versions of the document. Perform the

following steps to use the Track Changes feature:

1. Open a document containing the text.

2. Select the Edit>Changes—=>Record option from the Menu bar.

3. Do some changes (insertions and deletions of text) in the document. The inserted text is displayed in a
different color and the deleted text with a strikethrough line.
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What is a worksheet in OpenOffice Calc? How is it related to a workbook?

A worksheet in the OpenOffice Calc application refers to a single sheet. A worksheet contains various cells
formed by rows and columns. The intersection of a row and a column is called a cell. A collection of such
worksheets is known as a workbook. By default, there are three worksheets in a workbook but you can
add more worksheets as per your requirement. You can also switch between worksheets by clicking their
respective tabs.

Define the cell of a worksheet. How can we identify a cell?

A cell is formed by the intersection of a row and a column. The unique identity or address of a cell is generated
by combining the number of the row and the letter of the column where intersection of the cell is formed. For
example, if a cell is formed at the intersection of row 1 and column A, then its address will be A1. Similarly,
the address of the cell formed at the intersection of row 2 and column E will be E2.

What are the different types of data that we can enter in a worksheet? Explain in brief.

Any data that you enter in an OpenOffice Calc worksheet is in the form of a number, formula, special
character, or text. The data you enter is considered either as a label or a value by the application. Whenever
an entry starts with the +, -, or .signs, the OpenOffice Calc application considers that entry as a value. Entries
containing an alphabet or a character, even if they start with a number, are called text entries. You can enter
the following three types of data in a worksheet:

o Label (Text)
o Numbers
o Formulas

How can we change the color of the text in a worksheet?

OpenOffice Calc provides you the functionality of changing the color of the text that has been entered in a
cell. You can select the desired color and apply on the text of the cell. Perform the following steps to change
the color of the text:

Select the text of a cell whose color you want to change.

Select the Format—>Cells option from the Menu bar. The Format Cells dialog box appears.
Select the Font Effects tab on the Format Cells dialog box.

Select the desired font color from the Font color drop-down list.

A e

Click the OK button to apply the selected font color to the selected text.
Define range commands and worksheet commands. List some worksheet commands.

In Calc, we use two types of commands—range commands and worksheet commands. Unlike the range
commands which affect only a range, the worksheet commands affect the entire data in a worksheet. The
following are some Worksheet commands:

o Saving a Workbook

o Opening an existing Workbook
o Clearing a worksheet

o Closing a workbook

Explain the steps to insert a blank cell in a document.

The OpenOffice Calc allows you to insert one or more blank cells in your worksheet. Perform the following
steps to insert blank cells:

1. Select a cell or a range of cells where you want to insert the blank cells.
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2. Select the Insert—=>Cells option from the Menu bar. The Insert Cells dialog box appears
3. Select the desired radio button for shifting the existing cells to make way for the new blank cells.
4. Click the OK button, the selected number of blank cells gets inserted in your worksheet.

Why do we use formulas in a spreadsheet? Discuss the way to enter a formula in a spreadsheet.

Formulas are an essential part of the spreadsheet program. They help in calculating and managing large
amounts of data. A formula generally consists of functions. You can consider a function as a predefined
formula that takes a value, performs calculation on that value, and finally returns the result. Functions are
frequently used when calculations are lengthy and complex. A formula is a combination of values, operators
(+,-,/,%, and cell addresses (e.g. A8, B2, etc.). While using formulas, you can refer to cells, cell ranges, names
or labels that represent those cells or cell ranges. In Calc, formulas start with the = (equal) sign. For example,
if you want to calculate the sum of two cells (A2 and B2), the formula to calculate this sum will be =A2+B2.

What does cell referencing means in OpenOffice Writer? Explain briefly.

Cell referencing is the method by which you refer to a cell or series of cells in a formula. Cell references are

an important part of creating formulas in a spreadsheet program. Cell referencing is of three types:

o Relative cell referencing: When a formula is copied to a new location in a worksheet, cell references in
the formula change in relation to the new location of the formula.

o Absolute cell referencing: In absolute cell referencing, cell references in a formula remain the same even
when the formula is copied to a new location.

o Mixed cell referencing: In mixed cell referencing, one part of the cell address is an absolute reference
while the other part is a relative reference.

Write a note on the IF() function.

The IF() function compares two values and returns one of them, depending on some predefined set of
conditions. The syntax of the IF() function is shown in the following line of code:
=IF (test; “wvaluel”; “value2”)

In the preceding code line, the test is a logical condition or expression that returns a logical value (True or
False). If the test condition returns the true value, then valuel is returned by the IF() function; otherwise,
value?2 is returned. If you do not provide value2, then it is assumed to be False and if value1 is not provided,
then it is assumed to be True.

Write a note on the COUNTA() function.

The COUNTA() function is similar to the COUNT() function with the only difference that the COUNTA() function
also calculates the text entries. The COUNTA() function counts the total number of values in the list of
arguments. The syntax of the COUNTA() function is shown in the following code line:

=COUNTA (valuel; wvalue2;....; valuel)

In the preceding code line, valuel, value2, ...., valueN are arguments that are passed to the COUNTA()
function. These arguments can be of any type, such as number, text, and logical.

Chapter 9: Spreadsheet Tool —0penOffice Calc-Il
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Write a note on the importance of data formatting in a worksheet.

Formatting data helps in enhancing the appearance of a worksheet. You can make your data bold, italic, or
underlined to attract the viewer’s attention. Data formatting has numerous forms, such as number formatting
and text formatting. For example, in a worksheet containing students’ marks, you may want to highlight
the ‘A’ grade students with green color and ‘B’ grade students with blue color. You can do this easily in Calc
through data formatting.

Write the steps to change the font of the text in an OpenOffice Calc document.
Perform the following steps to set the desired font in the OpenOffice Calc:
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Select the data or cell range that you want to format.

Select the Format—>Cells option from the Menu bar. The Format Cells dialog box opens.
Select the Font tab.

Select the required font, typeface, and size in the Font tab.

Click the OK button.

What is a chart? Explain the different types of charts in OpenOffice Writer.

vk W=

Charts or graphs are pictorial representations of data that have always been considered as good mediums
to attract the attention of readers or viewers. You can easily explain an idea or concept by presenting it in
the form of a chart. A chart is a medium that is used to graphically present worksheet data in Calc. A chart is
the best way to compare and show the relationship between two data items, such as the sales volume of a
product in two years. OpenOffice Calc provides different types of charts to present your worksheet content in
different ways. Calc supports the following charts:

o Area chart

o Pie chart

o Column chart

o Bar chart

o Line chart

o Net chart

o XY (Scatter) chart

o Stock chart

o Column and Line chart
o Bubble Chart

Explain briefly the steps to create a chart in OpenOffice Calc.

In Calc, a chart is embedded as an object on a worksheet. An embedded chart is fixed with the source data in
a worksheet. In Calc, you cannot save a chart without its source data. Perform the following steps to create a
chart:

Select the cell range that contains the source data whose chart we want to make.

Select the Insert->Chart option from the Menu bar. The Chart Wizard appears.

Select a chart type in the Choose a chart type list box. The Choose a data range page appears.
Select the Data series in columns radio button.

Check both check boxes—First row as label and First column as label.

Click the Next button. The Customize data ranges for individual data series page appears.
Click the Next button. The Choose titles, legend and grid settings page appears.

Type Company Name in the x-Axis text box and Number of Units Sold in the y-Axis text box.
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Click the Finish button. The chart is created and displayed in your worksheet.
How can we print a worksheet with charts?

There are two different ways to print a worksheet:
o Print the entire worksheet.
o Specify the range of current worksheet.

Perform the following steps to print the worksheet:
1. Select the File=>Print option in the Menu bar. The Print dialog box appears.
2. Select the printer on which you want to print the worksheet.

3. Select the Print only selected sheets radio button in the Range and copies section to print the selected
sheets.
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Select the All sheets radio button under the Print content section.

Click the up or down arrow of the Number of copies spin box to increase or decrease the number of
copies that you want to print.

6. Click the Print button.

vk

Q6. Explain briefly the steps to insert a table in a worksheet.

Ans. A table can be inserted in a worksheet using the Table Control icon. You can define data fields to display or
edit data similar to the format of a database.
Perform the following steps to insert a table in a worksheet:
Click the View menu and place the mouse on the Toolbars option.
Click the View menu and place the mouse on the Toolbars option. The Form Controls toolbar appears.
Click the More Controls icon in the Form Controls toolbar. The More Controls toolbar gets displayed.
Click the Table Control icon in the More Controls toolbar.
Drag the mouse over the worksheet to insert a table. The Table Element Wizard - Data appears.
Select the data source in the Data source dropdown list.
Select a table from the Table/Query list box.
Click the Next button. The Table Element Wizard- Field Selection appears.

Select the fields from the Existing fields list box Click the => > button to add the selected fields from the
Existing fields list box to the Selected fields list box.

10. Click the Finish button.
11. Click the Design Mode On/Off icon. The data appears in the table.
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Q7. What is the difference between a Stock chart and a Net chart?

Ans. The difference between a stock chart and a net chart are shown in the given table:

STOCK CHART NET CHART

A stock chart is used to demonstrate the market A net chart is used to display data as points
movement in terms of the opening price, bottom connected by some lines in a grid or net that looks
price, top price, and closing price. like a spider net or a radar tube.

A stock chart uses the lines with markers to show The connected points of the net chart are used to
the data series. represent data.

The height of a marker helps you to measure values. There are different radials for each row of data.

Q8. Compare a Bar chart and a Pie chart.

Ans. The difference between a bar chart and a pie chart are shown in the given table:

BUBBLE CHART PIE CHART

A bar chart is used to demonstrate comparison A pie chart is a round chart that is divided into
among individual items. It is mainly used to zones, which demonstrate the proportional size of
highlight a comparison of values; therefore, it an item with respect to the sum of all the items.
organizes values horizontally and categories

vertically.

* Abar chart is also known as a histogram. * [t divides the whole or parts of a whole.

e It displays numerical dimensions. * It is easily understandable.

* It displays comparisons. e It places the biggest fraction first in the clock-

. . wise position.
e It allows multiple comparisons. P

e It labels larger portions in a circle and smaller
portion outside with connecting lines.
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Write down the steps to align text in OpenOffice Calc.

Perform the following steps to set text alignment in OpenOffice Calc:

1. Select the data or cell range that you want to format.

2. Select the Format—>Cells option from the Menu bar. The Format Cells dialog box opens.

3. Select the Alignment tab.

4. Select the required alignment for your text, such as Horizontal and Vertical in the Text alignment section.
The data will be aligned according to your selection.

What is number formatting? Explain the steps to format a currency in OpenOffice Calc.

Number formatting is used to change the appearance of numbers. When you format a number, it does not
affect the real cell value, which is used to perform calculations. We can apply number formatting on different
categories of numbers such as number, date, time, currency, fraction, boolean, etc. Perform the following
steps to format currency:

1. Select the data or cell range that you want to format.

2. Select the Format—>Cells option from the Menu bar. The Format Cells dialog box appears.
3. Select the Numbers tab.

4. Select the Currency option from the Category list box.

5. Select the currency format from the Format drop-down list.

6. Select the desired option from the list box.
7. Click the OK button to apply the format.

Chapter 10: Presentation Tool —OpenOffice Impress
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What is Presentation Graphics software? Give some examples.

Presentation graphics software is a special type of software that helps you create attractive, eye-catching, and
professional-looking visual aids for users. These visual aids help you communicate ideas, messages, and other
information in an easy and effective manner. Today, many presentation graphics software are available in the
market, such as PowerPoint, OpenOffice Impress, Photoshop, and Flash.

What is a presentation? Explain in brief.

A presentation is a sequential collection of slides in which each slide displays some information in the form of
text or graphics. A slide is an electronic page that contains information in the form of text, images, and audio/
video clips. For inserting text in your presentation, you need to insert text boxes. Further, you can make your
presentation more attractive, appealing, and eye-catching by adding animation and other effects to slides.

What is a slide? Explain the different elements of a slide.

A slide is an electronic page that contains information in the form of text, images, and audio/video clips. A
slide contains various elements, such as title, subtitle, drawing object, clip art, picture, and graph. These
elements are explained as follows:

o Title: Refers to the heading of the slide. The title element provides a basic idea about the topic and
content of the presentation.

o Subtitle: Refers to the description of the slide data. It also gives emphasis to the central idea of the slide.

o Drawing objects: Refer to the various built-in shapes provided by the Impress. These include shapes, such
as curves, lines, and flow chart.

o Clip art and pictures: Refer to the graphical objects that help in enhancing the appearance of a slide. The
OpenOffice suite provides built-in pictures in the picture gallery.

o Graph: Refers to the graphical object that allows you to draw relationship between objects in a slide.
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Ans. It is not always possible to display all the information related to a topic on main slides. To convey such
information, sometimes you need to take the help of certain additional components, such as handouts,
speaker notes, and outlines in a slide.
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The following are the components of a slide:

o

o

o

Handouts: Refer to the smaller printed versions of slides.
Speaker Notes: Refer to the small pictures of slides along with some descriptive notes.
Outlines: Refer to the summarized version of slides that contain only the title and the main text.

What is an empty presentation in OpenOffice Impress? Explain the different steps to create an empty
presentation.

An empty presentation is a blank presentation with no formatting applied to slides. Perform the following
steps to create an empty presentation:

1.

Select the Applications—> Office> OpenOffice 4.1.1Impress option to start the Impress application. The
Presentation Wizard appears.

Select the Empty presentation radio button in page 1 of the Presentation Wizard.
Click the Next button to move on to the next page in Presentation Wizard.

Select the Presentation Backgrounds option from the drop-down list under the Select a slide design
section in Presentation Wizard to change the background of slides. A list of related options appears in
the list box (Figure 4).

Select the desired option from the list box to set a background for the slides. In our case, we have selected
the <Original> option (Figure 4).

Select the desired radio button under the Select an output medium section to select the output medium
for your presentation.

Click the Next button to move on to the next page in Presentation Wizard. Page 3 of the Presentation
Wizard appears.

Select the desired effect for the slide from the Effect drop-down list under the Select a slide transition
section.

Select the desired speed for your selected effect from the Speed drop-down list under the Select a slide
transition section.

10. Select either the Default or Automatic radio button under the Select the presentation type section to

11.

select whether or not the presenter changes the slide manually or it happens automatically.

Click the Create button in the Presentation Wizard to create an empty presentation. An empty presentation
is created.

What does the term View in OpenOffice Impress mean? Explain the different types of views in OpenOffice
Impress.

Views refer to the mode of viewing presentations. In Impress, there are six types of views, such as Normal,
Outline, Notes, Handout, Slide Sorter, and Slide Show. Each of these views displays a distinct picture of the
presentation, enabling you to focus on different aspects of the presentation at different times. Various types
of slide views are explained as follows:

o

Normal View: Allows you to format, design, and add text, graphics, and animation effects to the slide. The
normal view is the default view for creating slides.

Outline View: Shows all the slides of a presentation in the numbered sequence and their contents in the
outline form. This view helps you modify your presentation easily and efficiently.

Notes View: Allows you to add or edit notes in the slides.

Handout View: Contains 1 to 6 thumbnails of the slides. A handout is a special view of a presentation,
which is meant to be printed and distributed to the audience.
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o Slide Sorter View: Displays all the slides of a presentation. In this way, you can verify the order of slides
and also verify whether the presentation has been completed or not.

o Slide Show View: Allows you to see each slide of your presentation in full screen on your computer.
Explain the steps involved in saving a presentation.

You need to save your presentation from time to time; otherwise, you may lose the changes that you have
made due to any unexpected event, such as power cut or system failure. Perform the following steps to save
your presentation:

Click the File menu on the Menu bar. A dropdown menu appears.

Select the Save option from the drop-down menu. The Save as dialog box appears.

Navigate to the directory where you want to save the presentation.

Type the name of the presentation in the File name combo box.

vk W =

Click the Save button to save the presentation.
Now, your presentation is saved with the specified name.
In how many ways can we insert a new slide in OpenOffice Impress? Explain any one way in brief.

By default, Impress provides only one slide in a blank presentation. However, you can add any number of
slides in a presentation. You can add or insert slides in four ways—through the Insert menu, by right-clicking
the slide, by clicking the Slide button in the Standard toolbar, and from the Slides pane.

To insert a slide from the Slides pane, right-click the slide after which you want to insert the slide and select
the New Slide option from the context menu.

What is a slide master? Explain the different types of slide masters found in OpenOffice Impress.

A slide master helps in defining the formatting and layout of all elements that are used for creating a slide.
The slide master can contain all the elements, such as text, picture, header, footer, slide number, and so on,
that a slide can have. In Impress, each slide in a presentation is based on a single slide master.

A presentation can have more than one slide master. In Impress, there are three types of masters:

o For slide: Designs the theme applicable on slides

o For notes: Designs the theme applicable on notes

o For handouts: Designs the theme applicable on handouts

Write a note on the Slide Sorter view in OpenOffice Impress.

In Impress, the Slide Sorter view refers to a view that shows thumbnail versions of all your slides arranged in
horizontal rows. This view is useful to make global changes to several slides simultaneously. Using the Slide
Sorter view, you can easily arrange the order of slides, create duplicate slides, and also delete them. You can
easily switch to the Slide Sorter view by clicking the Slide Sorter button available on the top of the slide.

apter 11: Societal Impact of IT

What is ICT? Why is it relevant today?

ICT is known as Information and Communications Technology, which emphasizes on imparting knowledge in
the field of education. It helps individuals or institutions handle information by using computers and other
digital technologies. ICT promotes usage of audio-visual equipment for imparting knowledge majorly at the
school or college level.

With the passage of time, ICT has proved to be an essential and basic step in the development of the modern
society. In many countries, the learning of the concepts of ICT is considered as an important part of education.
ICT has wide scope in various fields, such as education, healthcare, governance, design and manufacturing,
and business.
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Write the benefits of ICT in education.

Nowadays, teachers often use computers (electronic media) to teach students. The following are the benefits
of ICT in education:

o The use of computers in the education domain has simplified the learning of students.

o By using ICT, teachers of primary and secondary schools have made the learning of students interactive
and enjoyable.

o Generally, students find images and pictorial representations of concepts more interesting as compared
to theoretical knowledge. Therefore, teachers explain complex topics in a simplified manner by using
images, videos, and simulations.

o The use of ICT in education has brought a positive impact on the success of students from various
perspectives, such as knowledge, comprehension, practical and presentation skills.
What is Information Technology? Why has it become so important today?

Information Technology refers to the process of creating, storing, exchanging, processing, and using
information in its various forms, such as vocal, pictorial, textual, and numerical. Due to the IT revolution,
we are living today in the information era and our society is an information-led society. Information has also
come to be treated as an asset or property. Any information created by a person by investing his/her time,
money, and effort becomes the intellectual property of that person. It is our responsibility to understand the
value of someone’s intellectual property and prevent its misuse. Information misuse has led to the rise of
several ethical issues in our society.

What is plagiarism? How can we avoid it?

Plagiarism implies stealing ideas, thoughts, expressions, or writings of other persons. It is a type of intellectual
theft. Plagiarism can occur intentionally or unintentionally, such as through deliberate stealing or mistakenly
copying without acknowledgement of information that is categorized as someone’s intellectual property. The
following guidelines need to be considered to avoid plagiarism:

o You should have a clear understanding of plagiarism and its consequences so that you can stop
unintentional plagiarism.

o You should identify the sources of information that you are going to include in your work.

o If you need to copy a portion of someone’s work, ensure to enclose the copied portion in quotes and
state its source.

What is piracy? Explain the different forms of piracy.

Piracy refers to the act of creating duplicate copies of software without the owner’s permission. The following

are various forms of software piracy:

o Softlifting: Purchasing a licensed copy of software and uploading it on several computers by violating the
software license terms and conditions.

o Uploading and downloading: Creating copies of the licensed software or uploading and downloading it
from the Internet.

o Software counterfeiting: lllegal selling and making replicas of the licensed or copyrighted software.

o Hard disk loading: Installing an illegal copy of software on the hard disk of a personal computer.

o Renting: Giving or selling licensed software to other persons for temporary use.

Discuss the different career options in IT domain.

The IT revolution has created many new fields, resulting in many career opportunities. The following are some

important careers in the IT sector:

o Programmer/Analyst: Implements the computer information system and develops programs for the
system by using programming languages

o Database Analyst: Designs and develops the information flow model and database architecture

o Database Administrator (DBA): Designs, implements, monitors, maintains, configures, and administers
the databases of an organization
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Hardware Engineer: Arranges and configures the hardware of a computer

Web Developer/Multimedia Developer: Develops multimedia content for websites. Multimedia developers
use programming and designing tools such as Macromedia Flash and Dreamweaver to develop interactive
and attractive applications.

Help Desk Executive: Provides support to customers and solves their software-related problems either
personally or through telephone.

Webmaster: Manages the implementation and administration of a website.

Information System (Technology) Manager: Handles the interior IT architecture (complete setup)of an
organization. IT managers handle various aspects of the IT department, such as databases, operating
systems, networks, technical support, computers, and server maintenance.

Network Administrator: Manages the Local Area Network (LAN) of an organization.

System Analyst: Analyzes the business requirements and recommends appropriate software and hardware
to meet those requirements.

Networking Engineer: Implements various network settings, such as LAN and WAN for an organization.
Network Security Analyst: Implements and maintains the network and security policies.

Computer Programmer: Develops programs to interact directly with an operating system.

Software Engineer: Designs and develops programs for computer systems and software applications.
System Administrator: Manages all the computer systems and operating systems of an organization.
Technical Writer: Manages documentation of hardware and software for a particular organization or for
third-party vendors.

Web Programmer: Develops programs for Web applications and websites.

PC Support Executive: Provides assistance to end users by troubleshooting and maintaining the computer
system

Discuss the laws to curb software piracy.

Ans. The following are three types of laws formulated to restrict software piracy:

Q8.

o

o

Copyright: It is a set of exclusive rights granted to developers or authors to protect their work. The
copyright law enables the author to protect his/her intellectual property from being pirated.

Patent: It is a set of exclusive rights granted by the national government to a developer or owner of an
intellectual property for its protection. You cannot use patented intellectual property without getting a
license from its patent holder.

Trademark: This is the registered word or logo identifying the manufacturer or distributor of a product.

Explain the term, Individual’s Right to Privacy.

Ans. The major issues regarding an individual’s right to privacy in the context of computing and information relate
to collecting, storing, and distributing the information. IT, with its enormous power to observe, communicate,
calculate, store, and retrieve information, can be used as an easy medium to invade others’ privacy. With
increase in the role of information in decision making processes, the risk of invading others’ privacy has also
increased. To secure an individual’s information privacy, we must not use technology to accumulate, save, or
distribute information that exclusively belongs to some other person.

Q9.

Write the benefits of protecting the intellectual property rights of individuals and organizations.

Ans. The protection of the intellectual property rights of individuals and organizations leads to the following
advantages:

o

)

Organizations and individuals are encouraged to develop new software applications and improve the
existing software standards.

An environment is created for the propagation of innovative thoughts and technologies.
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Q10. Explain the benefits of ICT in design and manufacturing.
Ans. The use of ICT in the design and manufacturing industry led to the introduction of Computer-Aided Design
(CAD) and Computer-Aided Manufacturing (CAM). The benefits of CAD and CAM are as follows:
o In CAD, errors in design can be detected quickly, resulting in less time in manufacturing a product.
o CAD allows designers to easily change their designs to match any amendments made by managers.
o CAM ensures adequate and identical quality of any number of products being manufactured.
o The company can have bigger profit margins by using CAM as there is no labor cost.
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